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Актуальність роботи – полягає у потребі при підготовці здобувачів за 

відповідними освітніми програмами застосування в навчальному процесі 

кафедри новітнього апаратно-програмного забезпечення та інформаційних 

технологій. 

Мета роботи – створення апаратно-програмного та методичного 

забезпечення лабораторного практикуму «Програмне та технічне забезпечення 

промислових комунікацій»» на базі обладнання Simatic S7. 

Об’єктом дослідження є інформаційні процеси в промислових 

комунікаційних мережах на основі протоколів TCP «Open User Communication». 

Розроблено конфігурацію апаратних засобів для лабораторного 

практикуму на основі PLC S7-1200, виконано параметрування і налагодження 

комунікаційного середовища проекту. Розроблено прикладне програмне 

забезпечення для обміну даними між двома PLC на основі протоколу TCP «Open 

User Communication». 

Наведено приклад адаптованої до практикуму інструкції із застосування 

програмного пакету «SIMATIC Automation Tool» для ідентифікації, 

параметрування, діагностики і обслуговування мережевих пристроїв Simatic S7 

на основі PROFINET. 

Практичне значення роботи полягає у розробленні апаратно-програмного 

та методичного забезпечення лабораторного практикуму «Програмне та 

технічне забезпечення промислових комунікацій» з можливістю виконувати 

практикум з використанням середовища розробки TIA Portal і симулятора 

PLCSIM. 
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ВСТУП 

 

Актуальність теми полягає у потребі при підготовці здобувачів за 

відповідними освітніми програмами застосування в навчальному процесі кафедри 

новітнього апаратно-програмного забезпечення та інформаційних технологій. 

Метою роботи є створення апаратно-програмного забезпечення 

лабораторного практикуму «Програмне та технічне забезпечення промислових 

комунікацій»» на базі обладнання Simatic S7. 

Завдання розробки – апаратно-програмне та методичне забезпечення 

лабораторного практикуму «Програмне та технічне забезпечення промислових 

комунікацій». 

Об’єктом дослідження є інформаційні процеси в промислових 

комунікаційних мережах на основі протоколів TCP «Open User Communication». 

Розроблено конфігурацію апаратних засобів для лабораторного практикуму 

на основі PLC S7-1200, виконано параметрування і налагодження 

комунікаційного середовища проекту. Розроблено прикладне програмне 

забезпечення для обміну даними між двома PLC на основі протоколу TCP 

«Open User Communication». 

Наведено приклад інструкції із застосування програмного пакету 

«SIMATIC Automation Tool» для ідентифікації, параметрування, діагностики і 

обслуговування мережевих пристроїв Simatic S7 на основі PROFINET. 

Практичне значення роботи полягає у розробленні апаратно-програмного 

та методичного забезпечення лабораторного практикуму «Програмне та технічне 

забезпечення промислових комунікацій» з можливістю виконувати практикум з 

використанням середовища розробки TIA Portal і симулятора PLCSIM. 

Особистим внеском здобувача є опрацювання технічної документації, 

адаптація проекту до задач лабораторного практикуму, тестування апаратно-

програмного забезпечення і розроблення частини прикладного програмного 

забезпечення практикуму.  
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1 ОРГАНІЗАЦІЯ ПРОМИСЛОВОЇ КОМУНІКАЦІЇ НА ОСНОВІ 

«OPEN USER COMMUNICATION» 

 

1.1 Комунікаційні протоколи Ethernet для PLC Simatic S7-1200 

 

PLC Simatic S7-1200 підтримує наступні протоколи через комунікаційну 

мережу Ethernet (табл. 1.1) [1, 2]: 

- Transmission Control Protocol (TCP); 

- ISO on TCP (RFC 1006); 

- User Datagram Protocol (UDP). 

Таблиця 1.1 - Протоколи та інструкції з комунікації для кожного 

Протокол 
Приклади 

використання 

Ввід даних в 

область 

приймання 

Комунікаційні 

інструкції 
Тип адреси 

TCP 
Комунікація 

CPU-CPU 

Режим 

ADHOC 

TSEND_C, 

TSEND, 

TRCV_C, 

TRCV 

Призначає номери портів 

Локальний (активний) і 

Партнерські (пасивні) 

пристрої 

Data Reception 

with Specified 

Length 

TSEND_C, 

TRCV_C, 

TSEND, TRCV 

- - - 

ISO on TCP 

Комунікація 

CPU-CPU 

Фрагментація 

та повторна 

збірка даних 

Режим 

ADHOC 

TSEND_C, 

TSEND, 

TRCV_C, 

TRCV 

Призначає TSAP для 

Локальні (активні) та 

Партнерські (пасивні) 

UDP 

Комунікація 

CPU-CPU 

Комунікаційні 

програми 

користувача 

User Datagram 

Protocol 

TUSEND, 

TURCV 

Призначає номери портів 

для 

Локальні (активні) та 

Партнерські (пасивні) 

S7 

Сommunication 

Комунікація 

CPU-CPU ввід-

вивід CPU 

Передача 

даних і 

прийом з 

визначеною 

довжиною 

GET та PUT 

Призначає TSAP для 

Локальні (активні) та 

Партнерські (пасивні) 

PROFINET IO 

CPU-to-

PROFINET 

Комунікація 

пристрою 

вводу-виводу 

Передача 

даних і 

прийом з 

визначеною 

довжиною 

Вбудований Вбудований 
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Для розроблення апаратно-програмного забезпечення лабораторного 

практикуму «Програмне та технічне забезпечення промислових комунікацій»» 

вибрано один з протоколів «Open User Communication», що підпримуються 

PLC Simatic S7-1200, а саме TCP, як один з найпоширеніших. 

 

1.1.1 Протоколи TCP та ISO-on-TCP 

Протокол управління передачею даних TCP - стандартний протокол, 

визначений у стандарті RFC 793. Основною задачею протоколу TCP є 

забезпечення надійної та безпечної комунікації, в тому числі між PLC. 

Комунікаційний протокол TCP має наступну функціональність: 

- ефективний протокол зв'язку, оскільки він тісно пов'язаний з апаратним 

забезпеченням; 

- підходить для середніх і великих обсягів даних (до 8192 байтів); 

- забезпечує значно більше можливостей для застосування, зокрема, 

обробку помилок, керування потоком та надійність; 

- протокол, орієнтований на з'єднання; 

- можна гнучко використовувати з іншими системами і апаратно-

програмними засобами, які підтримують ТСР; 

- можливість маршрутизації; 

- застосовуються лише статичні довжини даних; 

- повідомлення підтверджуються; 

- комунікація за допомогою номерів портів; 

- більшість протоколів користувацьких програм, таких як TELNET і FTP, 

використовують TCP; 

- необхідні навики програмування для керування даними через 

SEND/RECEIVE інтерфейси програмування. 

Використовуючи точки доступу до служб транспорту (TSAP), протокол TCP 

дозволяє використовувати кілька з'єднань до однієї IP-адреси (до 64K з’єднань) 

[4]. За допомогою RFC 1006 TSAP однозначно ідентифікуються з'єднання цих 

кінцевих точок зв'язку з IP-адресою. 
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1.1.2 Режими роботи TCP Open User Communication 

PLC S7-1200 підтримує протоколи, наведені в табл. 1.1. Для кожного 

протоколу, PLC призначає параметри адреси, відповідний рівень зв'язку, а також 

роль комунікацій та напрямок комунікацій. Ця інформація дозволяє узгодити 

заходи безпеки для захисту систем автоматизації до використовуваних 

протоколів [3]. 

Режим ADHOC. Як правило, протоколи TCP та ISO-on-TCP отримують 

пакети даних визначеної довжини, від 1 до 8192 байт. Проте програмні інструкції 

TRCV_C і TRCV_С також надають «спеціальний» режим комунікації, який може 

приймати пакети даних змінної довжини від 1 до 1472 байтів. Якщо зберігати дані 

в оптимізованому блоці даних «Optimization DB», можна отримувати дані тільки в 

масиви форматів даних Byte, Char, USInt і SInt. 

Наприклад: Якщо потрібно отримати п'ять 100 байтових пакетів одним 

викликом, TCP буде доставляти ці п'ять пакетів як один 500-байтовий пакет, а 

ISO-on-TCP буде реструктурувати пакети на п'ять 100-байтових пакетів. 

 

1.1.3 Ідентифікатори комунікаційного з'єднання для команд 

Коли записуються програмні інструкції TSEND_C, TRCV_C або TCON 

PROFINET програма STEP 7 створює екземпляр DB для налаштування каналу 

зв'язку (або з’єднання між пристроями). 

Параметри ідентифікатора з’єднання: 

- ідентифікатор з'єднання повинен бути унікальним для PLC. Кожне 

підключення, яке створюється, має мати інший DB та ідентифікатор з'єднання; 

- локальний процесор і центральний процесор можуть використовувати той 

самий ідентифікаційний номер з'єднання ,але при цьому ідентифікаційні номери 

з'єднання не потрібні. Ідентифікаційний номер з'єднання відповідає лише 

інструкціям PROFINET у прикладній програмі; 

- можна використовувати будь-який номер для ідентифікатора з'єднання 

PLC. Однак налаштування ідентифікатора з'єднання послідовно з «1» надають 

простий спосіб відстеження кількості пристроїв, які використовуються. 
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1.2 Конфігурації комунікації на основі TCP Open User Communication 

Зв'язок між двома PLC, які використовують два окремі з'єднання для 

передачі і прийому даних (рис. 1.1): 

- інструкція TSEND_C в CPU_1 посилається на TRCV_C в CPU_2 за 

першим з'єднанням ("ID з'єднання 1" на обох CPU_1 і CPU_2); 

- інструкція TRCV_C в CPU_1 посилається на TSEND_C в CPU_2 за другим 

з'єднанням ("ID з'єднання 2" на обох CPU_1 і CPU_2). 

 

Рисунок 1.1 – Комунікація між двома PLC S7-1200 

Порядок з'єднання двох PLC: 

1) TSEND_C на CPU_1 створює з'єднання та призначає ідентифікатор 

з'єднання до цього з'єднання (ID з'єднання 1 для CPU_1); 

2) TRCV_C на CPU_2 створює з'єднання для CPU_2 і призначає ID 

з'єднання (ідентифікатор з'єднання 1 для CPU_2); 

3) TRCV_C на CPU_1 створює з'єднання для CPU_1 і призначає інший 

ідентифікатор для цього з'єднання (ідентифікатор з'єднання 2 для CPU_1); 

4) TSEND_C на CPU_2 створює друге з’єднання і призначає інший ID 

з'єднання для цього з'єднання (ідентифікатор з'єднання 2 для CPU_2). 
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1.3 Параметрування комунікаційних з’єднань PLC S7-1200 

Структура блоку даних DB, що відповідає за комунікацію TCON_Param 

визначає параметри протоколів TCP, ISO-on-TCP та UDP (табл. 1.2). 

Таблиця 1.2 Структура DB TCON_Param для комунікаційного з'єднання 
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1.4 Комунікаційні програмні інструкції TSEND_C і TRCV_C 

Програмна інструкція TSEND_C поєднує функції інструкцій TCON, 

TDISCON і TSEND. Інструкція TRCV_C поєднує функції інструкцій TCON, 

TDISCON і TRCV. 

Мінімальний розмір даних, які можна передати (TSEND_C) або отримати 

(TRCV_C) - це один байт; максимальний розмір – 819 2байти. TSEND_C не 

підтримує передачу булевих типів даних, а TRCV_C не може отримувати булеві 

типи дани (табл. 1.3). 

TSEND_C встановлює TCP або ISO-on-TCP підключення, передає дані і 

може припинити з'єднання. Після встановлення з'єднання або автоматичного 

встановлення, з'єднання підтримується та контролюється PLC (рис. 1.2) [5]. 

 

Рисунок 1.2 – Програмна інструкція для передачі даних TSEND_C 

Програмна інструкція TRCV_C встановлює комунікаційне з’єднання TCP 

або ISO-on-TCP з PLC, приймає дані і може припинити з'єднання (рис. 1.3). 

 

Рисунок 1.3 – Програмна інструкція для прийому даних TRCV_C 
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Таблиця 1.3 Типи даних для параметрів TSEND_C і TRCV_C 
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Програмна Інструкція TSEND_C виконується асинхронно і реалізує 

наступні функції: 

1) Налаштування та встановлення комунікаційного з’єднання. TSEND_C 

встановлює комунікаційне з'єднання при дозволяючому сигналі на вході REQ. 

Після встановлення, з'єднання автоматично підтримується і контролюється PLC. 

Параметри комунікаційного з’єднання визначені на вході CONNECT 

використовуються для налаштування зв'язку. 

Існуюче з'єднання припиняється, а встановлене з'єднання - видаляється, 

якщо PLC переходить в режим STOP. 

2) Передача даних через існуюче з'єднання. Завдання відправки 

виконується, коли на вході REQ сканується позитивний фронт сигналу. спочатку 

встановлюється комунікаційне з'єднання. Вказується область передачі з 

параметром DATA (див. табл. 1.3). Це включає адресу та довжину даних для 

передачі. Не можна використовувати область даних з типом даних BOOL або 

масивом BOOL в параметрі DATA. За допомогою параметра LEN вказується 

максимальна кількість байтів для передачі. Якщо використовується символьне 

ім'я за параметром DATA, LEN параметр повинен мати значення "0". Дані, які 

потрібно передати не можна змінювати до завершення передачі. 

3) Розірвання комунікаційного з’єднання. Комунікаційний зв'язок 

розривається після передачі даних, якщо CONT параметр має значення «0» під час 

додатнього фронту на вході REQ. В іншому випадку комунікаційне з’єднання 

буде підтримуватися. Якщо завдання передачі даних виконано успішно, параметр 

DONE встановлюється в «1». Стан сигналу «1» в параметрі DONE не є 

підтвердження того, що дані, які було надіслано, вже були прочитані 

комунікаційним партнером. TSEND_C скидається, якщо для параметра COM_RST 

встановлено значення «1». 

Програмна інструкція TRCV_C виконується асинхронно і реалізує функції: 

1) Налаштування та встановлення зв'язку. TRCV_C встановлює 

комунікаційне з'єднання, якщо параметр EN_R=«1» і немає зв'язку. Для з'єднання 

використовуються параметри, вказані CONNECT. 
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Існуюче з'єднання припиняється, а встановлене з'єднання - видаляється, 

якщо PLC переходить в режим STOP. Для налаштування та встановлення нового 

з'єднання, потрібно виконати TRCV_C з EN_R=«1». 

Якщо параметр EN_R встановлено на «0», перш ніж буде встановлено 

комунікаційне з'єднання, з'єднання буде встановлено і буде підтримуватись, 

навіть якщо CONT=«0». При цьому, дані не будуть прийняті (параметр DONE 

залишиться в «0»). 

2) Прийом даних через існуюче комунікаційне з'єднання. Прийом даних 

активовано, якщо параметр EN_R встановлено в «1». Як описано вище, спочатку 

встановлюється комунікаційне з’єднання. Довжина області прийому визначається 

за допомогою параметра LEN. 

3) Розірвання комунікаційного з’єднання. Комунікаційне з’єднання 

припиняється після отримання даних, якщо параметр CONT мав значення «0», 

при встановленні з'єднання. В іншому випадку комунікаційне з’єднання буде 

підтримуватися. Якщо завдання прийому успішно виконано, параметр DONE 

встановлюється в «1». TRCV_C скидається, коли встановлено в «1» параметр 

COM_RST. 

Через асинхронну обробку програмної інструкції TSEND_C дані потрібно 

зберігати у відправника. Для TSEND_C стан TRUE для параметра DONE означає, 

що дані були передані успішно (табл. 1.4). 

Таблиця 1.4 - Інструкції параметрів BUSY, DONE і ERROR 

BUSY DONE ERROR Стан параметру 

1 0 0 Обробляється задача передачі даних 

0 1 0 Передача даних виконана успішно 

0 0 1 

Встановленно комунікаційне з'єднання, 

Передача даних завершена з помилкою. 

Причина помилки вказанв в параметрі STATUS. 

0 0 0 
Не було призначено жодного нового завдання 

на передачу даних. 

 

PLC S7-1200 має порт PROFINET і підтримує комунікаційні програмні 

інструкції TSEND_C і TRCV_C, на основі яких і розроблено лабораторний 

практикум «Програмне та технічне забезпечення промислових комунікацій»».  
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2 АПАРАТНО-ПРОГРАМНЕ ЗАБЕЗПЕЧЕННЯ ПРАКТИКУМУ 

«ПРОГРАМНЕ ТА ТЕХНІЧНЕ ЗАБЕЗПЕЧЕННЯ 

ПРОМИСЛОВИХ КОМУНІКАЦІЙ» 

 

 

2.1 Організація обміну даними між PLC S7-1200 на основі TCP 

Open User Communication 

 

Мета лабораторного практикуму 

Створювати, конфігурувати, параметрувати і програмувати проекти для 

організації обміну даними між компонентами розподіленої системи управління на 

основі TCP Open User TCP communication [4]. 

Завдання лабораторного практикуму 

1) виконати інсталяцію TIA Portal (STEP 7 Professional і PLCSIM); 

2) створити проект на базі двох PLC S7-1200; 

3) виконати конфігурацію апаратних засобів проекту; 

4) виконати параметрування апаратних засобів проекту; 

5) налагодити комунікацію між PG/PC і PLCSIM; 

6) створити прикладну програму на мові FBD (Fuction Block Diagram) 

стандарту IEC 61131-3; 

7) створити блок даних DB з визначеною структурою і форматами даних, 

що підлягають передачі між двома PLC; 

8) організувати TCP Open TCP Сommunication між двома PLC з обміном 

даними у визначених форматах; 

9) виконати тестування проекту в симуляторах PLCSIM в режимі 

«run-time». 
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2.2 Методика виконання лабораторного практикуму 

1) Створити комунікаційне з’єднання між PLC_1_SEND і PLC_2_RECV 

використовуючи мережу PROFINET/Industrial Ethernet_1 (рис. 2.1) [5]. 

 

Рисунок 2.1 – Комунікаційне з’єднання між PLC_1 і PLC_2 використовуючи 

мережу PROFINET/Industrial Ethernet_1 

2) Параметрувати PLC_1_SEND та PLC_2 в меню «Properties» (рис. 2.2). 

 

Рисунок 2.2 - Параметрувати PLC_1_SEND та PLC_2_RECV в меню «Properties» 
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3) Вставити в дереві проекту функцію «FC1» і блок даних «DB8» в папці 

«Program blocks» використавши команду «Add new block» (рис. 2.3). 

 

Рисунок 2.3 - Установка функції «FC1» і блок даних «DB8» в папці «Program 

blocks» використавши команду «Add new block» 

Провести налаштування глобальних блоків даних «DB» в параметрі 

«Attributes» без опції «Optimized block access» для PLC_1_SEND (рис. 2.4). 

 

Рисунок 2.4 - Налаштування глобальних блоків даних «DB» в параметрі 

«Attributes» без опції «Optimized block access» для PLC_1_SEND 
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Такі ж операції провести для PLC_2_RECV. 

4) Відкрити глобальні блоки даних «DB» в дереві проекту для PLC_1_SEND 

та PLC_2_RECV, а також створити для них структуру даних з визначеним 

форматом (рис. 2.5) [6]. 

 

Рисунок 2.5 – Відкриття глобального блоку даних «DB8» в дереві проекту для 

PLC_1_SEND та PLC_2_RECV і сворення з визначеним форматом 

5) В організаційному блоці програмного циклу PLC «Main [OB1]» 

розробити прикладну програму на мові FBD (Functional Block Diagram) для 

запису даних визначеного формату в глобальний блок даних «DB8» для 

PLC_1_SEND та для їх передачі в PLC_2_RECV на основі TCP Open User 

Communication (рис. 2.6). 

На рис. 2.7 показано прикладну програму на мові FBD для передачі даних 

визначеного формату в глобальний блок даних «DB8» для PLC_1_SEND, що 

створена в програмному блоці функції «Block_1 [FC1]» і повинна 

завантажуватись в програмний цикл PLC - «Main [OB1]». 
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Рисунок 2.6 – Прикладна програма на мові FBD для передачі даних визначеного 

формату в глобальний блок даних «DB8» PLC_1_SEND 

 

Рисунок 2.7 – Прикладна програма на мові FBD для передачі даних визначеного 

формату в глобальний блок даних «DB8» для PLC_1_SEND,  

Завантажити функцію «Block_1 [FC1]» з дерева проекту у блок програмного 

циклу «Main [OB1]» PLC_1_SEND (рис. 2.8). 
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Рисунок 2.8 – Завантаження функції «Block_1 [FC1]» з дерева проекту у блок 

програмного циклу «Main [OB1]» PLC_1_SEND 

6) У блоці програмного циклу «Main [OB1]» PLC_1_SEND завантажити 

комунікаційну програмну інструкцію «TSEND_C» з меню розділів програмних 

інструкцій: «Communication» → «Open user communication» (рис. 9). 

 

Рисунок 2.9 – Завантаження «TSEND_C» в програмний цикл «Main [OB1]» 

PLC_1_SEND з «Communication» → «Open user communication» 
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Виконати параметрування входів-виходів програмної інструкції 

«TSEND_C» (див. рис. 2.9). Виходи діагностики під’єднати до екземплярного 

блоку даних (Instanse Data Block) «TSEND_C_DB [DB2]» (рис. 2.10). 

 

Рисунок 2.10 – Під’єднання виходів діагностики («DONE», «BUSY», «ERROR» і 

«STATUS») програмної інструкції «TSEND_C» до «TSEND_C_DB [DB2]» 

Визначити вхід «DATA» із синтаксисом P#DB8.DBX0.0 BYTE 29. Число 

повинно вказувати загальну суму байтів даних, що передаються з урахуванням 

формату даних: 

- Byte – 1 байт (байт); 

- Int – 2 байти (Integer - ціле число); 

- DInt - 4 байти (Double Integer - подвійне ціле число); 

- Word - 2 байти (Word - слово); 

- DWord - 4 байти (Double Word - подвійне слово); 

- Real - 4 байти (Real - число з плаваючою точкою); 

- LRyal – 8 байт (LReal - число з плаваючою точкою з подвійною точністю). 

 

Вхід «Connect» параметрується після завантаження і налаштування 

програмної інструкції «TSEND_C» в «Properties» для PLC_1_SEND (рис. 2.11). 
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Рисунок 2.11 – Налаштування програмної інструкції «TSEND_C» в «Properties» 

для PLC_1_SEND 

Таке ж параметрування виконати для програмної інструкції «TRECV_C» 

для PLC_2_RECV (рис. 2.12-2.13). 

 

Рисунок 2.12 – Завантаження «TRECV_C» в програмний цикл «Main [OB1]» 

PLC_1_SEND з «Communication» → «Open user communication» 
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Рисунок 2.13 – Налаштування інструкції «TSEND_C» для PLC_1_SEND 

При цьрму, структура даних в глобальних блоках даних «DB» в 

передаючому і приймальному PLC повинна бути однаковою. 

7) Виконати компіляцію обох PLC. Виконати завантаження кожного PLC з 

проекту в симулятор PLCSIM. Виконати симуляцію проекту в режимі «on-line». 
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2.3 Симуляція проекту в симуляторі PLCSIM в режимі «on-line» 

На рис. 2.14-2.15 показано результати симуляції в симуляторі PLCSIM [7-9] 

програмних блоків «DB8» i «TSEND_C» в режимі «on-line». 

 

Рисунок 2.14 – Симуляція блоку даних «DB8», що підлягає передачі через 

програмну інструкцію «TSEND_C» в програмі симуляторі PLCSIM в «оn-line» 

 

Рисунок 2.15 – Симуляція комунікаційної програмної інструкції «TSEND_C» в 

програмі симуляторі PLCSIM в режимі «оn-line» 
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На рис. 2.16-2.17 показано результати симуляції в симуляторі PLCSIM 

програмних блоків «DB4» i «RECV_C» в режимі «on-line». 

 

Рисунок 2.16 – Симуляція блоку даних «DB4», що підлягає передачі через 

програмну інструкцію «TRECV_C» в програмі симуляторі PLCSIM «оn-line» 

 

Рисунок 2.17 – Симуляція комунікаційної програмної інструкції «TRECV_C» в 

програмі симуляторі в режимі «оn-line» 
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Таким чином, в результаті симуляції проекту » в програмі симуляторі 

PLCSIM отримано такий результат – інформаційні дані у визначеному форматі з 

блоку даних «DB8» успішно передані з PLC_1_SEND у блок даних «DB4» 

PLC_2_RECV. 
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3 ІНСТРУМЕНТАРІЙ «SIMATIC AUTOMATION TOOL» 

ДЛЯ ПАРАМЕТРУВАННЯ І ДІАГНОСТИКИ PLC 

 

У сучасних автоматизованих системах керування промисловими процесами 

важливу роль відіграє правильна конфігурація мережевих параметрів пристроїв, 

таких як PLC, панелі оператора, децентралізовані модулі вводу-виводу тощо. 

Одним з інструментів для параметрування, діагностики та обслуговування 

пристроїв у мережі PROFINET є «SIMATIC Automation Tool» - інструментарій 

для швидкого і зручного виконання базових мережевих операцій та інших 

операцій [10-11]. 

 

3.1 Робота з мережевими функціями 

«SIMATIC Automation Tool» забезпечує встановлення IP-адрес та імен 

PROFINET для окремих пристроїв у мережі. Окрема увага приділяється типовим 

ситуаціям, таким як наявність однакових IP-адрес або імен, робота з 

непідтримуваними пристроями, особливості налаштування після 

перезавантаження та обмеження, пов’язані з використанням маршрутизаторів. 

 

3.1.1 Вибір мережевого інтерфейсу для комунікації з PLC 

Необхідно вибрати мережевий інтерфейс до мережі PROFINET. 

Команда «Auto» застосовується для автоматичного додавання IP-адреси до 

мережевого інтерфейсу для комунікації з пристроями пристроїв (рис. 3.1). 

 

Рисунок 3.1 – Автоматичний вибів IP-адреси 
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3.1.2 Сканування комунікаційної мережі 

Активувати кнопку на панелі інструментів, щоб просканувати мережу 

PROFINET на наявність усіх пристроїв (рис. 3.2). Під час сканування в мережу 

надсилається DCP (Digital Content Protection) broadcast-команда [12-13]. 

«SIMATIC Automation Tool» відобразить у «Device table» усі доступні пристрої. 

 

Рисунок 3.2 – Режим сканування комунікаційної мережі 

3.1.3 Додавання пристроїв за маршрутизаторами 

Вибрати команду меню «Edit > Insert > Device» або «Edit > Insert > Multiple 

Devices», щоб додати пристрої, які знаходяться за маршрутизаторами, до таблиці 

«Device table» (рис. 3.3). Ці команди також доступні через відповідну піктограму. 

Сканування мережі не виявляє пристрої за маршрутизаторами, оскільки 

вони не реагують на DCP broadcast-команду. Щоб додати такий пристрій, 

необхідно окремо ввести його IP-адресу. «SIMATIC Automation Tool» відображає 

пристрої, що знаходяться за маршрутизаторами синім текстом у «Device table». 

 

Рисунок 3.3 – Додавання пристроїв за маршрутизаторами у «Device table» 
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3.1.4 Робота з «Device table» 

«Device table» відображає підключені пристрої. «SIMATIC Automation Tool» 

показує колонки з даними про кожен пристрій. Щоб виконати операцію, 

необхідно оберати пристрій, встановивши маркер зліва. Далі скористатися 

панеллю інструментів або головним меню, щоб вибрати потрібну операцію. 

Можна вибрати декілька пристроїв, і «SIMATIC Automation Tool» виконає 

обрану операцію для всіх вибраних пристроїв (рис. 3.4). Якщо PLC захищено, 

активувати колонку «Password», щоб ввести облікові дані для автентифікації 

пристрою. Більшість операцій у «SIMATIC Automation Tool» вимагають наявності 

прав на читання та запис для PLC. 

 

Рисунок 3.4 – Відображення доступних мережевих пристроїв 

3.1.5 Зчитування «Event Log» 

У нижній частині вікна «SIMATIC Automation Tool» розташований 

«Event Log». Коли обираються пристрої та виконуються операції, «Event Log» 

відображає результати виконаної операції для кожного пристрою (рис. 3.5). 

Якщо PLC захищено, необхідно ввести пароль рівня доступу або пароль 

користувача з правами читання та запису, щоб мати змогу виконувати більшість 

операцій у «SIMATIC Automation Tool». 
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Рисунок 3.5 – Відображення результатів виконаних операцій 

3.2 Розширена функціональність «SIMATIC Automation Tool» 

«SIMATIC Automation Tool» показує пристрої, підключені до мережі 

(рис. 3.6). Можна обрати один або кілька пристроїв для виконання операцій. 

 

Рисунок 3.6 – Вивід доступних пристроїв в «SIMATIC Automation Tool» 

За допомогою «SIMATIC Automation Tool» можна виконувати такі задачі: 

- ідентифікація пристроїв; 

- додавання пристроїв; 

- перегляд діагностики пристроїв; 

- зчитування службових даних із пристроїв; 

- установка режиму роботи PLC; 

- установка часу на PLC; 

- установка IP-адреси; 

- установка PROFINET-імені; 

- скидання параметрів зв’язку; 

- скидання пристроїв до заводських налаштувань. 
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Вивід рядка стану 

У нижній частині вікна «SIMATIC Automation Tool» розташований рядок 

стану. У ньому відображається кількість пристроїв у таблиці пристроїв, типи цих 

пристроїв, скільки з них не доступні в мережі та скільки пристроїв обрано. Під час 

виконання операцій відображається кількість ще не завершених операцій для 

кожного типу. У меню Довідка (Help) програми «SIMATIC Automation Tool» є 

доступ до каталогу пристроїв. Це файл Microsoft Excel, що містить перелік 

підтримуваних пристроїв і версій. Для кожного пристрою вказані доступні 

операції. 

 

Встановлення таймера поточного часу на PLC 

Як приклад розглянемо випадок, коли потрібно встановити час пристрою 

для PLC у мережі. Під час сканування мережі знайдено три пристрої, які вже 

мають IP-адреси (рис. 3.7). Для цієї операції оберіть одну з перших п’яти вкладок 

у таблиці пристроїв. 

 

Рисунок 3.7 – Приклад встановлення таймера поточного часу на PLC 

Щоб встановити час пристрою відповідно до часу вашого програмного 

пристрою, виконайте такі кроки: 

Якщо у стовпці "Trust TLS Certificate" для пристрою відображається 

повідомлення "Selection needed", потрібно встановити довіру на "Always", щоб 

мати можливість виконувати операції з пристроєм. 
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Операції сканування мережі 

Щоб просканувати мережу, активувати кнопку «Scan» на панелі 

інструментів. Також можна вибрати команду меню «Operations > Scan Network». 

Сканування виявляє пристрої, які підключені безпосередньо до мережі через 

Ethernet-інтерфейс — або на самому пристрої, або через підключений модуль CM 

чи CP. 

Також є можливість відфільтрувати сканування, щоб воно охоплювало 

лише конкретні пристрої в мережі. Для налаштування фільтрації необхідна 

розширена ліцензія. Щоб виконати сканування з фільтром, активувати кнопку 

«Filtered Scan» на панелі інструментів або виберіть відповідну команду з меню 

«Operations > Scan Network». Після сканування в таблиці пристроїв «Device table» 

відображатимуться лише ті пристрої, що відповідають фільтру. 

Якщо таблиця пристроїв містить пристрої, які більше не підключені до 

мережі, їхні рядки відображатимуться курсивом. Також можна вручну додати 

один або кілька пристроїв у таблицю. Осередки, що підсвічені червоним 

кольором, вказують на необхідність введення даних (рис. 3.8). 

 

Рисунок 3.8 – Результат сканування пристроїв 

Ідентифікація пристроїв 

Проблема з ідентифікацією пристрою може виникнути, наприклад, якщо 

після останнього сканування мережі були внесені зміни до пристрою через 

TIA Portal. Така проблема також може виникнути у разі відмови пристрою. 
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«SIMATIC Automation Tool» не виконує жодних операцій над пристроєм, у 

якого є проблема з ідентифікацією. 

Якщо пристрій з MAC-адресою вже існує в таблиці, сканування мережі 

оновлює поля IP-адреси, Підмережі та Шлюзу для цього рядка таблиці пристроїв. 

Усі інші поля даних залишаються незмінними. Якщо сканування мережі 

знаходить новий пристрій, тоді SIMATIC Automation Tool» створює новий рядок 

для пристрою. 

 

Порівняння фактичного обладнання з конфігурованим 

Якщо PLC в мережі відрізняється від конфігурованого PLC, колонка 

«Configuration» таблиці пристроїв вказує результат порівняння. Запис може 

містити один або декілька з наступних результатів порівняння: 

- діагностична помилка; 

- не сконфігуровано; 

- відповідає; 

- не відповідає. 

Для PLC, SIMATIC Automation Tool» порівнює фактичний PLC з 

конфігурацією, а також наступне: 

- дисплей (тільки S7-1500); 

- сигнальні плати; 

- локальні сигнальні модулі. 

SIMATIC Automation Tool» оцінює наступну інформацію для порівняння: 

- тип пристрою; 

- артикул; 

- версія мікропрограми. 

Сканування мережі оновлює колонку «Configuration» для всіх пристроїв у 

мережі. Крім того, коли ви оновлюєте пристрій або виконуєте операцію над 

пристроєм, SIMATIC Automation Tool» оновлює колонку «Configuration» для 

вибраного пристрою або пристроїв. Як і багато інших колонок таблиці пристроїв, 

можна показати або приховати колонку «Configuration». 
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Вставка одного або кількох пристроїв 

Можна вставити пристрій у «Device table». Додати можна лише пристрій, 

який є унікальним серед інших пристроїв. SIMATIC Automation Tool» підтримує 

пристрої, що знаходяться за маршрутизаторами. 

Щоб вставити пристрій, виконати такі дії: 

- вибрати команду меню «Insert > Device» у меню «Edit» або активувати 

відповідну піктограму. 

У діалоговому вікні «Insert Device» вибрати тип адреси для введення: 

– Device IP Address; 

– Device MAC address; 

– NAT Router IP Address. 

Якщо обрано IP-Address, ввести IP-адресу пристрою. 

За потреби змінити підмережу пристрою. 

Якщо обрано MAC-address, ввести MAC-адресу пристрою. 

Якщо обрано NAT Router IP-address, діалогове вікно зміниться і дозволить 

ввести таку інформацію: NAT Router IP Address - ввести IP-адресу NAT (Network 

Address Translation) роутера. NAT Router Subnet - за потреби змінити підмережу 

NAT роутера. Device IP address - ввести IP-адресу пристрою, який вставляється за 

роутером. Password. 

Якщо пристрій за роутером — захищений CPU S7-1X00, потрібно ввести 

пароль CPU або користувача, щоб дозволити вставлення пристрою в 

«Device table» (рис. 3.9). 

«SIMATIC Automation Tool» перевіряє коректність даних пристрою. Адреса 

пристрою або пара адрес роутера та пристрою повинні бути унікальними в 

мережі. Введений пароль повинен забезпечувати дійсну автентифікацію для 

захищеного пристрою. Якщо перевірка успішна, «SIMATIC Automation Tool» 

вставляє пристрій у «Device table». Якщо перевірка неуспішна, у «Event Log» 

відображається повідомлення про помилку. 
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Рисунок 3.9 – Приклад встановлення пристрою за маршрутизатором 

IP-адреси NAT роутера 

Для багатьох типів NAT роутерів NAT Router IP address — це фізична IP-

адреса NAT роутера. Роутер транслює одну мережеву IP-адресу на IP-адресу 

іншого пристрою. NAPT (Network Address and Port Translation) роутери 

забезпечують кілька IP-адрес, які налаштовують як «Mascarad», щоб представляти 

кілька NAT роутерів з «Destination IP» адресами. Для кожної Destination IP-адреси 

налаштовують Translated Destination IP-адресу [14]. 

Для «SIMATIC Automation Tool» NAT Router IP-address може бути будь-

якою з налаштованих Destination IP-адрес. IP-адреса пристрою буде Translated 

Destination IP-адресою, що відповідає NAT Router (Destination IP) Address, який 

налаштовано. 

 

Ідентифікація мережевих пристроїв 

Для пристроїв на кореневому рівні у таблиці пристроїв «Device table» 

операція «Identify» допомагає фізично локалізувати пристрої в мережі. 

Локалізація пристрою за допомогою блимання світлодіодів або екранів HMI 

Можна використовувати операцію «Identify» у режимі RUN та режимі 

STOP. Щоб ідентифікувати пристрої, виконати наступні дії: 
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Виберати один або кілька пристроїв для включення в операцію. Можна 

скористатися маркером «Devices» у верхній частині таблиці пристроїв 

«Device table», щоб вибрати або зняти вибір з усіх пристроїв. Як альтернатива, 

можна скористатися командою меню «View > Select», щоб отримати доступ до 

команд «Select Row(s)» та «Deselect Row(s)». 

Виберати команду меню «Operations > Identify» або активувати кнопку 

панелі інструментів для ідентифікації вибраних пристроїв. CPU, SCALANCE та 

інші пристрої блимають своїми світлодіодами для позначення свого 

розташування. Пристрої HMI виконують миготіння екрану. 

 

Ідентифікація непідтримуваних пристроїв 

Операція «Identify» є операцією на основі MAC-адреси, яка використовує 

DCP (Discovery and Configuration Protocol). «SIMATIC Automation Tool» може 

використовувати операції DCP MAC-адреси для всіх безпосередньо підключених 

мережевих пристроїв. 

Непідтримувані пристрої можуть не блимати світлодіодами або екранами 

HMI залежно від апаратної конфігурації пристрою. За замовчуванням «SIMATIC 

Automation Tool» відображає непідтримувані пристрої. Можна вимкнути цю 

опцію в налаштуваннях «General settings». 

 

3.3 Діагностика мережевих пристроїв 

Діагностика CPU містить запис для кожної події діагностики. Кожен запис 

включає дату та час виникнення події, категорію події та опис події. Записи 

відображаються у хронологічному порядку, де найновіша подія знаходиться вгорі. 

Коли журнал заповнюється, нова подія замінює найстарішу подію в журналі. При 

втраті живлення події зберігаються. 

Діагностика пристрою містить такі типи записів: 

- подія системної діагностики (кожна помилка CPU та помилка модуля); 

- зміни стану CPU (кожне вмикання живлення, перехід у STOP та перехід у 

RUN). 
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Можна скористатися маркером «Display device Time Stamp in PG/PC local 

time», щоб переглядати часові мітки у часі CPU або у часі персонального 

комп’ютера (PG/PC). 

 

Зчитування сервісних даних пристрою 

Якщо пристрій переходить у несправний стан, пристрій зберігає 

інформацію про несправність, яку можна завантажити на PG/PC. 

Сервісні дані містять декілька файлів, які стискаються в один файл формату 

.zip з іменем файлу, що базується на назві PLC та MAC-адресі. Унікальний номер 

у дужках додається до імені файлу, щоб уникнути дублювання імен файлів. 

Можна налаштувати або прийняти шлях до сервісних даних за замовчуванням у 

налаштуваннях «Service Data». 

Щоб зчитати сервісні дані з вибраних пристроїв, виконати наступні дії: 

- виберати один або кілька пристроїв для включення в операцію. Можна 

скористатися маркером «Devices» у верхній частині таблиці пристроїв 

«Device table», щоб вибрати або скасувати вибір усіх пристроїв. Як альтернатива, 

можна скористатися контекстним меню правої кнопки «миші» або командою 

меню «View > Select», щоб отримати доступ до команд «Select Row(s)» та 

«Deselect Row(s)»; 

- для кожного вибраного захищеного CPU активувати колонку «Password», 

щоб ввести автентифікаційні дані з правами доступу для читання для CPU; 

- вибрати команду «Operations > Diagnostics > Read Service Data», щоб 

розпочати операцію. Як альтернатива, активувати кнопку панелі інструментів 

«Show device diagnostics» і вибрати «Read Service Data» з контексного меню 

кнопки; 

- активувати кнопку «Continue" у діалоговому вікні "Upload Service Data". 

SIMATIC Automation Tool зчитує сервісні дані з вибраних пристроїв і 

зберігає файли в папці сервісних даних . Журнал подій (Event Log) показує 

результати операції. 

 



 

Зм. Арк. № докум. Підп. Дата 

Арк. 

41 КРБ.СІ - 02.00.00.000 ПЗ 

 

Встановлення режиму роботи CPU 

Щоб змінити режим роботи пристрою, виконайте наступні дії: 

- вибрати один або кілька пристроїв для включення в операцію. Можна 

скористатися маркером «Devices» у верхній частині таблиці пристроїв 

«Device table», щоб вибрати або скасувати вибір усіх пристроїв. Як альтернатива, 

можна скористатися контекстним меню правої кнопки «миші» або командою 

меню «View > Select», щоб отримати доступ до команд «Select Row(s)» та 

«Deselect Row(s)». 

Для кожного вибраного CPU ввести пароль, якщо використовується, у 

колонку «Password» на поточній відкритій вкладці. 

Встановити режим роботи на RUN або STOP: 

– виберати RUN у меню «Operations» або активувати кнопку RUN на панелі 

інструментів (рис. 3.10); 

– виберати STOP у меню «Operations» або активувати кнопку STOP на 

панелі інструментів(рис. 3.10). 

 

Рисунок 3.10 – Встановлення режиму роботи PLC (RUN або STOP) 

Потрібно підтвердити запит на зміну режиму роботи. Після того як 

підтверджено запит, «SIMATIC Automation Tool» встановлює для вибраних CPU 

режим RUN або STOP. «SIMATIC Automation Tool» не змінює режим роботи без 

підтвердження. 

Журнал подій «Event Log», розташований під таблицею пристроїв, 

відображає результати операції. 
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Встановлення імені PROFINET мережевого пристрою 

Щоб змінити ім’я PROFINET-пристрою, конфігурація пристрою в 

завантаженому проекті TIA Portal має підтримувати цю зміну. 

Дійсні імена PROFINET відповідають стандартним правилам іменування 

DNS (Domain Name System). Якщо ви введете недійсне ім’я, «SIMATIC 

Automation Tool» перетворить його у дійсне ім’я PROFINET. Можна побачити 

перетворене ім’я у колонці «PROFINET Converted Name». 

Щоб встановити ім’я PROFINET для одного або декількох пристроїв, 

виконати наступні кроки: 

- перейти на вкладку «Set PROFINET Name»; 

- вибрати один або декілька пристроїв для операції. Можна використати 

маркер «Device» у верхній частині таблиці пристроїв для вибору або зняття 

вибору всіх пристроїв. Також можна скористатися контекстним меню або меню 

«View > Select» для команд «Select Row(s)» та «Deselect Row(s)»; 

- ввести нове ім’я PROFINET у колонку «New PROFINET Name»; 

- вибрати команду «Update» в меню «Operations» або активувати кнопку 

«Update» і вибрати у контекстному меню «PROFINET Name» (рис 3.11). 

 

Рисунок 3.11 – Встановлення імені PROFINET для мережевого пристрою 

Операція «Update» встановлює нові імена PROFINET для вибраних 

пристроїв. Якщо ввести недійсне ім’я PROFINET згідно з правилами іменування 

PROFINET, «SIMATIC Automation Tool» виправить ім’я на дійсне. Колонка 

«PROFINET Converted Name» відображає перетворене ім’я. Журнал подій 

«Event Log» під таблицею пристроїв показує результати цієї операції. 
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Дублікат імен PROFINET, якщо два або більше пристроїв мають однакові 

імена PROFINET, «SIMATIC Automation Tool» позначає дублікати червоними 

клітинками. Для таких пристроїв «SIMATIC Automation Tool» підтримує повну 

функціональність та відображає всю іншу інформацію (рис. 3.12). 

 

Рисунок 3.12 – Відображення всієї інформації притсроїв 

Операції на основі MAC-адреси використовують DCP (Discovery and 

Configuration Protocol). DCP — це стандарт Ethernet. «SIMATIC Automation Tool» 

може використовувати операції DCP MAC-адрес для всіх безпосередньо 

підключених мережевих пристроїв (CPU, HMI, децентралізовані I/O та інші 

пристрої). 

Вибрати рядок непідтримуваного пристрою, ввести нові дані у відповідну 

колонку та оновити імена PROFINET непідтримуваних пристроїв так само, як і 

підтримуваних. Непідтримувані пристрої можуть не прийняти зміну залежно від 

апаратної конфігурації пристрою. За замовчуванням «SIMATIC Automation Tool» 

відображає непідтримувані пристрої. Можна вимкнути цю опцію в 

«General settings». 

Таким чином, застосування інструментарію «SIMATIC Automation Tool» 

забезпечує наступні функції при роботі з апаратними засобами Simatic S7: 

- ідентифікацію мережевих пристроїв; 

- додавання мережевих пристроїв пристроїв; 

- діагностику мережевих пристроїв; 

- зчитування службових даних із мережевих пристроїв; 

- установку режимів роботи і поточного часу PLC; 

- параметрувавання IP-адреси і PROFINET-імені мережевих пристроїв; 

- обслуговування пристроїв (скидання на заводські установки, оновлення 

мікропрограмного забезпечення).  
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ВИСНОВКИ 

 

1. На основі опрацювання технічної документації, розроблено апаратно-

програмне та методичне забезпечення лабораторного практикуму «Програмне та 

технічне забезпечення промислових комунікацій»» на базі обладнання Simatic S7. 

2. Виконано конфігурування, параметрування і налагодження 

комунікаційного середовища проекту. Розроблено прикладне програмне 

забезпечення для обміну даними між двома PLC S7-1200 на основі протоколу 

TCP «Open User Communication». 

3. Наведено приклад адаптованої до практикуму інструкції із застосування 

програмного пакету «SIMATIC Automation Tool» для ідентифікації, 

параметрування, діагностики і обслуговування мережевих пристроїв Simatic S7 на 

основі PROFINET. 

4. Розробленні апаратно-програмне та методичне забезпечення 

лабораторного практикуму «Програмне та технічне забезпечення промислових 

комунікацій» надає можливість виконувати практикум з використанням 

середовища розробки TIA Portal і симулятора PLCSIM. 
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БІБЛІОГРАФІЧНА ДОВІДКА 

 

 

Тема бакалаврської роботи: «Апаратно-програмне забезпечення 

лабораторного практикуму «Програмне та технічне забезпечення промислових 

комунікацій»». 

 

Обсяг пояснювальної записки в аркушах – 48 арк. 

 

Перелік креслень графічної частини: 

 

1) КРБ.СІ – 02.00.00.001 Е2 – Організація TCP «Open User Communication» 

між двома PLC S7-1200. Схема функціональна (аркушів - 1). 

2) КРБ.СІ – 02.00.00.002 Е2 – Апаратна конфірурація проекту на базі 

PLC S7-1200. Схема функціональна (аркушів - 1). 

3) КРБ.СІ – 02.00.00.003 Е2 – Комунікаційна програмна інструкція TSEND_C 

для передачі даних з PLC. Схема функціональна (аркушів - 1). 

4) КРБ.СІ – 02.00.00.004 Е2 – Комунікаційна програмна інструкція TRECV_C 

для прийому даних в PLC. Схема функціональна (аркушів - 1). 

5) КРБ.СІ – 02.00.00.005 Е2 – Блоки даних PLC з переданими і прийнятими 

даними визначеного формату. Схема функціональна (аркушів - 1). 

6) КРБ.СІ – 02.00.00.006 Е2 – Інтерфейс програмного забезпечення 

«SIMATIC Automation Tool». Схема функціональна (аркушів - 1). 
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